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What is new in  
 
 
 
Coach Version 7.7 (release January, 2021)  
 
Check the latest version of Coach 7 Help to find detailed information on the changes and 
improvements.  
 
New  
• Main Screen is now Dashboard with buttons for quick start of predefined (empty) Activities and 

easy access to other options. 
• Version and update check via the Dashboard button Check for Updates. 
• Possibility of resetting License via the Dashboard button Help > About Coach 7 (Author mode only). 
• Toolbars in the Data Video, Data Image, Video, Capturing video and Image panes.   
 
General improvements 
• Data Video and Data Image analysis are split respectively into the Data Video and Data Image types 

of Activities.  
• Installation includes only Tutorials in English and Dutch. For other languages they are part of the 

CMA projects, see next point. 
• CMA Projects are not included with the installation anymore. They have to be downloaded from the 

CMA site (Internet connection required). This can be done via the Dashboard button Download 
CMA Projects.  

 
Measurement 
• Additional feature added to keep interface inactive in all Activities/Results when Coach cannot 

establish the connection to any interface.  
• New (resizable) symbols are used on sensor/actuator icons.  
• When disconnecting a sensor with data the sensor icon is automatically removed from the panel 

(for automatically recognized sensors) or can be removed manually (for sensors selected from the 
Sensor Library). The data collected with the sensor are kept in the Data Table - the variable is no 
longer associated with the sensor but becomes the Manual Input type.  

• A “new” CMA sensor is now recognised based on its EEPROM even if it is not in the Coach Sensor 
Library yet.  

 
Data Video  
• The Tool menu options Time Calibration, Video Points and Frames are removed from the Tool menu 

and are now located on tabs of the Settings dialog available after pressing the Activity Toolbar 
button Settings.  

• The Data Video has now its own Toolbar offering some options previously present under the Tool 
menu of this window. 

• The Zoom button is added to the Data Video Toolbar. By default the video is Auto fit to the Data 
Video window.  

• The Magnifier is added to the Data Video Toolbar.  
• The Data Video control panel is modified. 
• A rotation angle Prot has been added as a variable which can be measured for video points. This 

allows the measurement of continuous rotating movements (for angles larger than 360 degrees).  
 
Data Video Capture  
• The Data Video now has its own Toolbar offering options previously present under the Tool menu 

of this window. 
 
Data Image  
• The Tool menu options Time Calibration, Video Points are removed from the Tool menu and are 

now located on tabs of the Settings dialog available after pressing the Activity Toolbar button 
Settings.  
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• The Data Image has now its own Toolbar offering some options previously present under the Tool 
menu of this window. 

• The Zoom button is added to the Data Image Toolbar. By default the image is Auto fit to the Data 
Image window.  

• The Magnifier is added to the Data Image Toolbar.  
• Data collected during the Image measurement can be sorted in the Data Table with exception of 

stroboscopic images.   
 
Analyze & Process Tools  
• New tool Change added. This option can be used to determine changes in data values both in 

horizontal and vertical directions. 
 
Bugs  
• Digital display in Animation editor corrected.  
• Scan display can be resized.  
• The Slope line is thicker.  
• A number of other small fixes.  
 
Version Coach 7.6 (release September, 2019)  
 
IMPORTANT for MAC Users: This version of Coach is the first 64-bit version.  
 
New  
• A new functionality added into the Tool menu of the Data Table Runs > Import Run.  

This option allows importing a Run from another Coach 7 Activity or Result file. The dialog shows 
information about runs and variables present in the imported Coach file, and uses a “more 
intelligent” way of matching variables from the imported file with variables in the Data Table.  

 
General improvements 
• The Statistics dialog is modified and shows nicer table.  
• The Panel image is now automatically zoomed for higher screen resolutions.  

 
Measurement 
The Sensor Library dialog is modified: 
• We do not divide Sensor Library into the CMA and the User sensor library anymore (no drop-down 

list to select the library type).  There is just one Sensor Library.  
• The sensor list can be sorted according to a sensor name or a sensor code.  
• Via check boxes the sensor list can be filtered to show only a selected sensor brand.  
• There is a new “group” of sensors flagged as old sensors. These can be selected when the checkbox 

CMA Archive is selected. Idea behind is to limit the sensor list to the latest CMA sensors, not 
showing all sensors always.  

• Coach remembers these settings.  
 
Data Table  
• The Data Table has now a toolbar with buttons/icons which allow directly to Zoom Text, Display 

properties of Run variables, Display properties of Data Series variables, Add Runs/Rows, Delete 
Run/Rows, Add Variables into Run Series/Data Series, Delete into Run Series/Data Series, Scan and 
to display Statistics.  

• Right-click a variable (the header of the table column) changes its functionality. It does not open 
directly Variable properties dialog but first displays the variable menu with options: Properties, 
Delete, Hide and Add new.  

• Right-click of a run number shows a run menu with options: Properties, Delete, Insert, Move Up and 
Move Down.    

• Run gets now its Properties dialog in which user can overrule the default color of a run and select 
another color. Note this the selected color will be used for all variables in this run.   
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Bugs  
• A slope is shown when using the mouse.  
• A number of fixes.  
 
Version Coach 7.5 (release March, 2019)  
 
New  
• Spreadsheet Activity is added as a new type of Coach Activity. This type of Activity should be used 

to manually create a data set or to import data into the data table for example from a csv file. Then 
the data can be displayed in graphs, analyze and process with tools available in Coach.  
After selecting the Spreadsheet activity you can directly select the number of empty rows, which 
will be created in the Data Table. By default these are 101 data rows. The number of rows can be 
modified via the Rows option available in the Tool menu of the Data Table.  
After the activity is opened the table is shown with the Run open and three columns.  
- Index, which displays the row numbers. 
- A and B columns defined as manual variables. These columns are empty. You can rename these 

variables or change their connection (AutoFill, Function).  
Now you can work with the Data table in the same way as in other type of activities.  

• AutoFill option is added as a variable connection.  This option automatically creates equidistant set 
of data. There two ways of defining the data fill:  
1. Via specifying the Start and the Stop value.  
2. Via specifying the Start and the Step value. 
Coach will automatically generate equidistant points in the given range and fills the values into the 
number of rows present in a run.  

• Support for measurement and control with the new WiLab.  
• The Change Interface option is added to the Tool menu of Panel pane.  

 
General improvements 
• Default settings change: the Data Table is by default displayed in the new made activity.  
• Dragging variables between axis and graphs: you can now drag a variable from axis of a graph and 

drop it to another axis of the same graph or drop it to an axis of another graph. Extra settings of 
that variable such as min and max, marker type or show peaks will be copied too.  

• The fonts size of label and scale used along graph axes can be set to bigger fonts via the Graph Tool 
menu option Text zoom . You can also zoom with <Ctrl> + <Shift> MouseWheel (<Ctrl> + 
MouseWheel zooms the graph).  

• The Variable properties option is added to the right-click menu of the Variables.  
• It is now possible to switch between AutoFill, Manual and Function in the variable connection in the 

Variable Properties dialog.  
• *.cma and *.cmr files are now opened by Coach 7.  
 
Modeling  
• In the Text mode you can now mix all three ways of writing: dt, deltat and Δt. 
• In the Text mode a space is added before model text lines.  
 
Bugs  
• Moving the divider in the Data table does not remove the run name anymore.  
• When dragging a manual or formula variable to x-axis of a graph it was still possible to achieve 

having twice the same value in the graph.  
• When Zoom to fit is used during a measurement, it zooms only the vertical axis and does not 

change the horizontal axis.  
• It is not possible to sort AutoFill and Function type of columns.  
• A number of small fixes.  

 
Version Coach 7.4 (release March 2018)  
 
Important (25.03.2018):  
The Windows Coach 7.4 installation has been modified to not reset the Author key to the default value 
after update. This means that a file, which consists this Author key, will not be overwritten during Coach 
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Installation. Unfortunately for installation of Coach 7.4 on some systems a direct upgrade (installation 
when an older version of Coach is installed) does not work correctly. In such situation, the file is deleted 
and not replaced by the new one, and you get an error message Cannot read Author key file. It may be 
missing or corrupt. There are two ways to solve this problem:  
1. First uninstall the older version of Coach and after that install the new Coach 7.4, or  
2. Run "Program and Features" repair. 
  
New  
- Spectrometer Activity is added as a new type of Coach Activity. This Activity allows to work with the 

new CMA Spectrometer and to record the Emission and Absorption spectra. For more details see 
the Coach 7 Help System.   

- Show peak values option is added to the Graph Properties dialog. When this option is checked the 
peaks of the variable showed in the graph are labelled with their respective values. This option is 
very useful when displaying spectra.     

- The Smooth option now has now two options: 
New Formula - as a result a new Formula variable is added to the existing run. The new variable is 
calculated based on the formula used for smoothing:  

a. the Filter formula for the Moving average method,  
b. the Spline formula for the Spline method, and  
c. the Bezier formula for the Bezier method.    

As a result a graph displaying a new "smoothed" variable is created. Coach draws a smoothed line, 
for which points are computed for each pixel and not only for the values on the horizontal axis. The 
line is not extrapolated outside the measurement points.    
Note that when you use Spline with the manually set factor then the same factor will be used in the 
formula applied to all runs, while the factor may "not work well" for other runs. If you leave the 
factor on Automatic then it will be automatically chosen for each run based on the data of that run. 
New Run - as a result a new Run with a modified set of data is added. The new data set may consist 
of more points than the original data set (only Spline and Bezier methods) and can successively be 
processed.  

 
General improvements  
• Vietnamese language is added to the list of available languages 
- Improvements of painting smooth graphs with limited number of data 
- The Formula Editor dialog is modified:  

- it shows for which variable a formula is being defined and,  
- descriptions of variables and parameters required for a specific formula are added to the 

listed functions  to help understanding how a formula has to be constructed.  
• New function fit y=a/x^2 
- Use of splitters in Model and Control window:  

In a Text model activity all types of users can freely move the splitter between the model and 
variable names.  
In a Control or Measurement activity with program the splitter can be freely moved only if the user 
is an Author or Senior student or if the initial splitter position (before running the activity) was not 
set to its most right position. Moreover, Junior student users cannot drag the splitter to its most 
right position. 

 
Measurement  
• Improvements of working with BT50i Light sensor  
• Firmware updates possible on Mac also 
• Sometimes detectable sensors are not automatically detected by an interface. This can happen for 

example when a Force sensor BT42i is connected to €Lab, and a USB port to which €Lab is plugged, 
does not deliver enough power. In such case:  
- if there is no sensor icon placed on the €Lab panel in Coach, right-click the empty input and 

select the sensor manually from the Sensor Library. 
- if the sensor icon is placed on the €Lab panel in Coach and remains grey (is not detected 

automatically) right-click the sensor icon and select Confirm.  
 
Data Video  
• The Pick a color dialog is now available in all settings of the Data Video window 
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• Default colors set to lighter colors 
• Annotations can handle multiple lines 
 
Modeling  
• Improvement of working with subsystems 
• Font dialog the same like the one in the Text editor 

 
Activities  
• New activity ‘8a. Approximation - Distance vs. Time.cma’ is added to Tutorials > Analyze & Process 
• The Activities ‘8b. Smooth > New Run (Moving average) - Acid-base titration’ and ‘8c. Smooth > 

New Run (Spline&Bezier) - Distance vs. Time’ are modified to reflect changes in Coach 
• New folder with Activities added into Tutorials > 11. Spectrometer 
• Vietnamese and Slovak Tutorial Activities are added 
 
Mac 
• High Sierra fix 
• Style of scrollbar changed for better visibility 
• Style for tab controls adapted to avoid different background colors in dialogs 
• Improvement of display options in dialogs.  
• Fix for closing of web browser. 
 
Bugs  
• Motion detector 0664 should work correct now with CoachLab II+ with serial numbers starting with 

SAG08/09 
• After the second sketch is made the new sketch is added to the graph but is not available in other 

places. 
• Clipboard handling improved 
• Bug fix handling circular references in formulas (helps loading "wrong" Coach 6 activities) 
• Bug fix loading Coach 6 (Windows) measurement activities without hardware on Mac 
• Handling undetected detectable sensors adapted (i.e. €Lab cannot detect some detectable sensors) 
• Drawing a sketch above the left scale activate the stretching of the graph.  
• Crash in Signal window when changing runs. 
• Bug in fac function. 
• Not selecting internal sensor when changing into €Sense. 
• A number of small fixes.  
 
Version Coach 7.3 (release September 2017)  
 
General improvements  
• Chinese-Taiwan language is added to the list of available languages.  
• The option Run > Insert is extended with possibility to directly insert a number of Rows in the new 

created Run.  
• A sequence of the Runs in the Data Table can be changed. Drag the selected run and drop it onto 

another run’s number and then it will be move above that run.  
(See also Tutorial > Data Table / Editing Data Table).  

• Double-click a Coach Activity/Result (cma7/cmr7 file) in Finder (MAC) starts Coach 7 (if it is not 
opened) and opens the selected Activity/Result.  

• A new Tutorial activity 6. Editing Data Table is added to Tutorials > 1. Data Table.  
• Activities in Tutorials > 3. Analyze and Process are adapted to reflect the latest changes of Smooth 

and Select/Remove tools.  
 
Hardware support 
• Drivers of the following interfaces are improved: CLAB, CoachLab II+, €Lab, €Lab with EuroMotion, 

€Motion, €Sense. They are now direct drivers, they do not use dll anymore but code is built into the 
Coach program (exe file). 
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• The Internal Microphone is added to the list of measurement interfaces. It allows measurements on 
the default sound recording device on your PC for Windows and Mac. 

 
Measurement 
• Typing a letter, when selecting a sensor from the Sensor Library, selects the first sensor in the list 

starting with this letter.  
 
Modeling 
• The Delta symbol is added into the command list available via the Menu button in the toolbar of 

Model window in Text mode. This allows inserting the delta symbol into a model.  
• The Simulate option is added to the Tool menu of the Model window in Text mode.  
• The Select Variables button is added to the toolbar and the Variable menu option is changed into 

Select variables option in the Tool menu of Text mode. This option allows selecting variables, which 
will be added to the Data Table and available for Graphs, Meters, Values and Animations. The 
available variables are directly listed in the dialog.   

• The Zoom button is added to the toolbar and the Zoom menu option is added to the menu of the 
Model window in Equation and Text modes.  

• Favorite button and its functionality is added to the Model window in Text mode.  
• The Favorite button shows the mode in which the stored model was created, Graphical or Text. Text 

models are visible only in Text mode.   
• A favorite model can replace or can be added to the current displayed model.  
• Annotations in Equation mode can be moved up and down:  

o on Mac, by using arrow up and down keys together with <cmd>-button  
o on Windows, by using arrow up and down keys together with <alt>-button. 

• The out-flow gets directly sign – not the combination of + and - .  
• By default the relation arrows are drawn in red and model objects in blue. These colors can be now 

adapted for a whole or a part of the model. To change a color:  
o Drag to select (a part of) a model in the Model window or use the Tool menu option Edit > 

Select all to select the whole model.  
o Go to the Tool menu option Edit > Color > Relations if you want to change the color of the 

selected relation arrows.  
o go to the Tool menu option Edit > Color > Objects if you want to change the color of the 

selected model objects. 
o select the desired color.  

 
 
Programming 
• The Own Command button is added to the toolbar of the Program Window.  
• The Select Variables button is added to the toolbar and the Variable menu option is changed into 

Select variables option in the Tool menu of Program Window in Control. This option allows selecting 
variables, which will be added to the Data Table and available for Graphs, Meters, Values and 
Animations. The available variables are directly listed in the dialog.  

 
Processing  
• The Copy Window to Clipboard button is added to all Processing windows. This button allows 

copying the Processing window as an image for use in other programs e.g. Word.  
• Scan: When the Scan option is selected the following functionalities are possible:   

o Click/Drag - goes to the closest measured point in x direction. 
o <Alt > + click/drag goes to the closest measured point in Euclidean metrics.  
o <Ctrl> (on Mac <Cmd>) + click/drag allows to freely scan regardless of measured points and 

shows the coordinates of the cross using the first y-axis only. 
o Holding <Shift> key allows zooming in Scan mode.     

• Function fit: when fixing function coefficient only Refine button can be used. Estimate button is 
disabled (grey).  

• Smooth: The functionality of the Smooth option is changed: the new data do not overwrite the 
original data anymore; these data are added as a new run. The Smooth option cannot be executed 
on a variable defined by formula.  
The Smooth option is now available in Data Video. 
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• Select/Replace: The functionality of the Select/Replace option is changed: the new data do not 
overwrite the original data anymore; these data are added as a new run.  
The Select/Replace option is now available in Data Video.  

 
Version Coach 7.21 (release June 2017)  
 
Bugs  
• Activity with an un-docked Data Table can be opened now.  
• The Windows error “Server Certificate Invalid or not present” does not appear anymore. 
• Small fixes  
 
Version Coach 7.2 (release March 2017) 
 
General improvements  
• The following languages are added: Czech, French, German, Italian, Polish, Spanish and Slovak. 
• For German, Polish and Spanish tutorial activities are present in the CMA Coach Projects.  
• Improvement of the on-line license check especially when there is a server problem.  
• New option File > Save for MoLab/VinciLab allowing saving Coach 7 activities in the format, which 

can be opened in the Coach 6 CE program on MoLab and in the Coach 6 App on VinciLab.  
• Possibility to save results (cmr7 files) on Mac.  
• Various corrections in the animation window, among others adding background image and 

switching between Cartesian and polar coordinates. 
 
Text Editor 
The text editor is completely renewed. It should work better than the previous editor and it has extra 
possibilities to:  
• place an image at the right or the left site of text.  
• save text as html file.  
Attention! When opening an activity, created in Coach 7.1, a conversion takes place. Sometimes this 
conversion may cause a different formatting. This will need to be updated manually.  
 
Hardware support 
• Support of Adam Equipment Highland Balance HCB602h. 
 
Measurement  
• Possibility of measuring and video capture at the same time (synchronized and not synchronized).  
• Possibility of synchronizing replay of a measurement with a video.  
 
Data Video/Video  
• Added capture functionality allowing to record videos via a webcam or an external USB camera for 

use in Coach.  
• Various improvements in video measurement among others faster tracking, correct tracking for 

larger videos, better synchronization between video and measurement graph. 
 

Modeling  
• Improvements of drawing graphical elements especially arrows.  
• Improvements of zooming in graphical mode.  
• Improvements of Constants table. 

 
Programming  
• Possibility to zoom program text.  

 
Bugs  
• Scanning multiple runs at the same time works for variables that were added later. 
• Manually set graph axes remain not changed after reopening activity.  
• Graph and Meter settings are not reset when different sensor in the same group is connected. 
• Own programming commands are editable.  



 8 

• Improvements of programming submenu and condition wizard.  
• Stop Condition in a text model can be set. 
• And many smaller fixes.  
 
Version Coach 7.1 (release October 2016) 
 
Coach 7 is the successor of Coach 6 and offers new features and enhancements of our unique and 
powerful environment for STEM Education. Compared to Coach 6, Coach 7 is renewed in many aspects 
(listed below) but our Coach 6 users will recognise many functionalities.  
 
1. Coach 7 runs on more platforms as well on Windows as on Mac computers.  

 
2. There are no separate language versions; Coach 7 offers more languages.  

 
3. Coach 7 is designed to look more modern and is enhanced with a more intuitive user interface.  
 
4. Coach 7 automatically detects connected interface(s) and adjust (where possible) the interface used 

in the Measurement or Control Activity being opened. This simplifies your work as an Author of a 
Coach Activity. Once created an Activity it can be used with different interfaces. 

 
5. Working with sensors and actuators in Coach 7 becomes easy.  

• No sensor and actuator panels anymore, the handling of sensor and actuator icons happens 
directly on the interactive interface panel on the screen. For most sensors no work is needed, 
these sensors are automatically detected and appear automatically on the interface panel. For 
old, not detectable sensors, just one click is needed to manually select the sensor from the 
Coach Sensor Library.  

• For beginner users all CMA sensors are calibrated with factory calibration and for many sensors 
more than one calibration is now provided. Just one click on the sensor icon and another 
sensor calibration may be selected.  

• More advanced users can create their own sensors or calibrate provided sensors themselves. 
The calibration procedure is made now very simple.  

• Additionally and especially for intelligent sensors, which have their own EEPROM memory and 
can be automatically detected, the calibration information included in the sensor memory can 
be read but also adapted and stored in the sensor’s EEPROM memory. In this way each physical 
sensor can have its particular accurate calibration. 

To learn more about new measurement features perform activities provided in the CMA Projects 
folder 1.Tutorials > 4. Measurement.  

 
6. Coach 7 offers easy work with data via the Data Table.  

Each Coach Activity has just one table with data; this table includes all variables and their data used 
in the Activity. The variables are created automatically based on Sensor, Video measurement or 
Modeling data. Variables for manual data or data generated by formulas can be simply added. 
There is no limitation in the number of variables used in the table but for better visibility variables 
(table columns) can by choice be hidden.  
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Finally, the wish of many users is now realised in Coach 7, the program can record many 
measurement runs per Activity.  
 

 
 
Run Series are displayed at the left side of the Data Table. Data Series, often Time Series, are 
displayed at the right side of the Data Table.  
Variables can be added as well to the left as to the right side of the Data Table. This allows adding a 
parameter (one value per Run) into Run Series or a new calculated quantity into Data Series (this 
quantity will be calculated, if possible, for all Runs in the Table).  
To learn how to work with Data Table perform activities provided in the CMA Projects folder 
1.Tutorials > 1. Data Table.  
 

7. Coach 7 has one Data Table but as many Graphs as you want and how you want.  
Similar to Coach 6 standard graphs can be created automatically via right-click on a sensor icon or 
on a model variable. But in Coach 7 also user-defined graphs can be created very quickly. Simple 
drag variable labels from the Data Table to axis of your new graph and the graph is ready. If you do 
not like the default settings you can change them easily in Graph Properties (unique for each 
graph). Zooming of graphs is also extended and improved.  
 

 
 
To learn more about new graph features perform activities provided in the CMA Projects folder 
1.Tutorials > 2.Graph.  
 

8. Meters and Values have new designs but still can be customised by users.  
 

9. A few useful features, wishes of our users, are added to improve our Modeling environment.  
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• A modified Flow graphical element/icon.  
• Improved the way of drawing model elements in Graphical mode.    
• Possibility to display all the mathematical equations hidden behind the model variable.  
• Possibility to add and collect your favourite models. These models are then available in other 

Modeling Activities.   
• Data created via the Simulate option in the Model window are added as new Runs to the Data 

Table.  
• Many tutorials to learn certain new functionalities are added to the provided CMA Activities, 

and they are located in the folder 1. Tutorials. 
 

10. Coach 7 is able to open Coach 6 Activities/Results, *.cma/*.cmr files, but in some cases of 
measurement activities some functionalities can be missing e.g. when special defined sensors are 
stored in the Activity/Result. The texts in Coach 7 activities loose their layout in Coach 7. 
Activity/Results of Coach 7 get the respective file extensions *.cma7/*.cmr7.  
 

11. Coach 7 offers a new, on-line Help System (html 5).  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

CENTRE FOR MICROCOMPUTER APPLICATIONS 
https:// cma-science.nl 


